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1. Version Management 

Version Update Description Table 

Version 
Number 

Content Time 

V1.0 
Add digital demodulation and pulse option 
measurement description 

2025-3-27 

V1.1 

1. Add phase noise test function description 

2. Pulse signal detection version description 

3. Modify trigger function introduction (based 

on the latest SAS4) 

2025-4-3 

V1.2 1. Add pulse signal test in DET mode 
2. Modify some details in the document 

2025-4-8 

V1.3 

1. Add requirements for operating 

environment and probability density chart 

section 

2. Remove SWP mode pulse detection and 

digital demodulation hardware dongle 

instructions 

2025-4-30 
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2. Quick Start Guide 

This chapter covers Quick Start Guide for PX series handheld spectrum analyzer, with key 

topics including safety instructions, instrument power on/off, SAStudio4 software operation 

and external interface descriptions. 

2.1 Safety Instruction 

2.1.1 Safety rules 

1. Please check the following items before running the instrument: 

▪ The appearance of instrument is intact; 

▪ The power cable and adapter are not damaged; 

▪ The fan's air vent is unobstructed; 

▪ The instrument is dry, without moisture or condensation; 

▪ The ambient temperature meets specifications in product datasheet; 

▪ If any damage is found before first operation, please contact HAROGIC official 

after-sales service. 

2. During operation, please follow these guidelines: 

▪ The fans work properly and the operating temperature meets the requirements 

from the product datasheet; 

▪ Please connect the external port properly and ensure that input signal level is 

within maximum input power; 

▪ Battery is suggested to be above 5%; 

▪ It is prohibited to open the instrument’s casing to avoid the risk of electric shock; 

▪ In case of any error, please contact HAROGIC official after-sales service. 

3. After completing the use of the instrument, please follow the guidelines below: 

▪ After the instrument is properly shut down, ensure that the storage temperature 

and humidity meet the range specified in the product datasheet. 

2.1.2 Replacing the power adapter 

If you are unable to use the original power adapter for certain situations, please select an 

appropriate power adapter according to the corresponding product datasheet. 

2.1.3 Replacing the battery 

The service for PX series battery replacement is officially offered. If you need to replace the 

battery, please contact official after-sales service for assistance. 

2.2 External Interface Description 

All external interfaces are integrated on the top panel of PX series instrument. Please refer to 

Table 1 for detailed information of each interface. 
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Table 1 Detailed information of external interface 

No Interface Description 

1 Power On/Off instrument 

2 Charging 
Instrument charging port, USB PD 20V 3.25A. Please 
connect the power supply according to the datasheet 

3 Micro HDMI For extended display 

4 USB3 
USB interface: USB3 is USB 3.0 interface, USB1 and 
USB2 are USB 2.0 interface. This interface connects to 
external storage devices, USB keyboards, or mice. It 
can also be used to connect a driver-free Hub with an 
Ethernet port, allowing the instrument to be remotely 
controlled by a PC via network cable 

5 USB2 

6 USB1 

7 Audio Output 3.5mm headphone jack. Volume can be adjusted via 
the menu: “System” → “Device” → “Volume.” 

8 MUXIO Please refer to Table 2 for more details 

9 Charging Indicator 
Light 

Green flash indicates charging, and green solid light 
indicates a full charge 

10 Analog IF Output MMCX(F), maximum output power -25 dBm, output 
impedance 50 Ω 

11 Trigger Output 3.3V CMOS 

12 Trigger Input 3.3V CMOS, high impedance input 

13 
Reference Clock 
Input 

MMCX (F), amplitude 1.5Vpp, input impedance 330 Ω. 
Sine wave, square wave, and clipped sine wave are 
supported 

14 GNSS Antenna MMCX (F), amplitude 1.5Vpp, input impedance 330 Ω 

15 RF Input N (F) or 2.4 mm (M), input impedance 50 Ω 



 

4 

Table 2 Pin description for MUXIO interface 8 (from left to right) 

Pin Name Direction Voltage 
Standard 

Description 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / 
Power output, 5V output 
for PXN-400 and PXE 
series 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 SYNC_RXRFLO I 3.3V RF LO synchronization 

11 SYNC_ADCCLK I 3.3V ADC clock 
synchronization 

12 SYNC_RXIFLO I 3.3V IF LO synchronization 

13 GND / / Ground 

14 REFCLK_OUT_FP O / 
Reference clock output 
outputs a standard clock 
signal of 10 MHz 

2.3 First Use of the Instrument 

The battery level may be below 5% after long-distance transportation. It is recommended to 

connect the power adapter before powering on the instrument for the first time. 

2.3.1 Power on/off the Instrument 

Turn on/off the instrument using the power button (Interface 1) on the top of the instrument. 

After powering on, the blue power indicator will light up. After powering off, the power indicator 

light will go out. 

2.3.2 Charging indicator 

When the instrument is connected to the power adapter, the charging status light (Interface 9) 

will flash green. Once fully charged, the charging status light will always stay on green. 
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2.3.3 SAStudio4 operation 

Press the power button to turn on the instrument. After booting up, the instrument will enter the 

desktop and automatically launch the SAStudio4 software. The standard operating UI is shown 

in the following picture: 
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3. SAStudio4 Operation Overview 

This chapter mainly explains the UI layout, working modes, and common features of SAStudio4 

software. 

3.1 Working Modes Overview 

PX series handheld spectrum analyzers offer working modes, including Standard Spectrum 

Analysis (SWP), IQ Streaming (IQS), Power Detection Analysis (DET), Real-time Spectrum 

Analysis (RTA), Phase Noise Measure and Basic Digital Demodulation. The measurement 

functions available in each working mode will be explained in the following sections. 

3.1.1 Standard spectrum analysis (SWP) 

In SWP mode, the instrument performs frequency hopping to realize frequency sweep. This 

mode is suitable for frequency trace-based measurement and analysis applications. The 

measurement and analysis functions provided in SWP mode include: 

◼ Spectrum panoramic sweep ◼ IP3/IM3 

◼ Local spectrum zoom display ◼ Channel Power 

◼ Waterfall graph ◼ OBW 

◼ Spectrum record and playback ◼ ACPR 

◼ Signal tracking ◼ Peak table 

3.1.2 IQ streaming (IQS) 

In IQS analysis mode, the instrument keeps the LO configuration unchanged to obtain IQ time 

domain data. IQS mode is suitable for time-domain signal recording, basic demodulation 

analysis, and other applications. The functions provided in IQS mode include: 

◼ IQ time domain waveform ◼ Spectrum analysis of IQ data 

◼ Waterfall graph ◼ AM/FM demodulation 

◼ Power-time waveform ◼ Audio analysis 

◼ Multi-channel DDC ◼ IQ record and playback 

3.1.3 Power detection mode (DET) 

In DET analysis mode, the instrument keeps the LO configuration unchanged to obtain IQ time 

domain data. DET mode is suitable for observing the relationship between time and power 

within a certain bandwidth. The functions provided in DET mode include: 

◼ Power-time waveform ◼ Record and playback 

3.1.4 Real time analysis mode (RTA) 

In RTA analysis mode, the instrument keeps the LO configuration unchanged to obtain IQ time 

domain data. RTA mode is suitable for applications that focus on transient and burst signals. 

The functions provided in RTA mode include: 

◼ Real-time spectrum probability density graph  

and waterfall graph 

◼ Record and playback 
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3.1.5 Phase Noise Measurement Mode (PNM) 

In phase noise measurement mode, the instrument provides high-precision phase noise 

spectra and detailed data tables through automated measurement technology. These 

measurement results help users to deeply analyze the phase stability, noise distribution, and 

noise density at different frequency offsets of the signal. The functions provided by the phase 

noise measurement mode include: 

◼ Single-sideband phase noise spectrum 
◼ Phase noise measure table 

3.1.6 Digital demodulation mode (Option71) 

In digital demodulation mode, the instrument demodulates the modulated signal and analyzes 

the modulation quality from various perspectives. The demodulation functionality is suitable for 

multiple applications, especially in environments where known modulated signals need to be 

analyzed, quality-assessed, and data extracted. The functions provided in digital demodulation 

mode include: 

◼ Constellation and eye diagram ◼ Bit table and demodulation 

◼ Modulated signal spectrum analysis ◼ ASK/FSK/PSK/MSK/QAM 

3.2 SAStudio4 UI Layout 

The SAStudio4 UI consists of the following sections: 

◼ Menu ◼ Graph Set Area 

◼ Graph Display Area ◼ Main Setting Area 

◼ Instrument State ◼ Parameter Quick Set 

 

Figure 1 SAStudio4 UI layout 

3.2.1 Menu 

◼ Save and load configuration ◼ Set startup state 
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◼ Working mode switch ◼ System setting  

◼ Single/Continue preview ◼ Record and playback 

◼ Quick screenshot ◼ GNSS, Instrument Information View 

3.2.2 Graph set area 

◼ Graph settings ◼ Trace settings 

◼ Marker settings ◼ Display Measurement Results 

3.2.3 Main settings area 

◼ Measurement and analysis settings ◼ Trigger settings 

◼ Data record and playback ◼ System settings 

3.2.4 Instrument state 

◼ Instrument model ◼ Software and firmware versions 

◼ Current instrument temperature ◼ Bus data throughput 

◼ GNSS antenna connection status ◼ Instrument battery status 

3.3 SAStudio4 Common Operation Overview 

3.3.1 Store or load configuration 

1. Store measurement configuration 

1) Meau-File-Save State; 

2) In the Save Configuration File dialog, set the save path and file name, then click Confirm to 

save the configuration file. 

 

2. Load configuration 

1) Menu-File-Recall state; 

2) In the "Please Select file" dialog, choose the configuration file and click "Confirm" to open 
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the previously saved configuration. 

 

3.3.2 Startup state settings 

PX series spectrum analyzers allow users to configure the instrument's startup state. The 

supported startup states are listed in Table 3. 

Table 3 SAStudio4 software startup state 

No Startup state Description 

1 Default Default configuration 

2 User Preset Use a user-saved configuration file as the startup state 
configuration 

3 Last State Use the parameter configuration when last software exit as 
the startup state configuration 

To configure the startup state, follow these steps: 

1. Click “File” in menu bar, and select “Power On State” to set the software startup state; 

2. For "Default" and "Last State", simply click the corresponding option. The software will use 

the state as the initial startup state when it is launched for the next time. 

3. To select "User Preset," click on the "Please Select File" dialog that appears, choose the 

user-saved configuration file, and then click "Confirm." The software will start with the user-

specified configuration next time. 
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3.3.3 Working modes switch 

Click on "Mode" to switch working mode to SWP, IQS, DET, RTA, or Digital Demodulation. 

 

3.3.4 Save a screenshot 

1. Click “File” in the menu bar, and select “Save Image”; 

2. In the “Save Image” dialog, set the image save path and file name, then click “Confirm” to 

save the screenshot (when no external storage is connected, the image will be saved locally by 

default; when external is connected, you can choose to save directly to external disk). 

Alternatively, you can use the shortcut key in the menu bar " " for quick screenshot. 
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3.3.5 GNSS information 

Click "System" in the menu bar, and select "GNSS Info". After selection, a "GNSS Info" pop-up 

window will appear. See Table 4 for key parameter descriptions in the pop-up window. 

 

Table 4 GNSS parameters description 

No Parameter Description 

1 Format "Local Time" and "UTC Time" 

2 Antenna Select "Internal Antenna" or "External Antenna" (currently 
only external antenna is supported) 
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3 SatNum Number of locked satellites/Number of visible satellites 

4 SNR(Max) Maximum signal-to-noise ratio (SNR) of the locked 
satellites/Maximum SNR of the unlocked satellites 

5 SNR(Min) Minimum SNR of the locked satellites/Minimum SNR of 
the unlocked satellites 

6 SNR(Avg) Average SNR of the locked satellites/ Average SNR of the 
unlocked satellites 

3.3.6 Preset 

Click on "Preset" to restore the software configuration to the instrument's default state. 

 

3.3.7 Single or Continuous preview 

Single Preview: Click "Single", Continuous Preview: Click "Continue". 
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3.3.8 Quick Record and Playback 

Quick Record: Click "Rec" to start recording data, and click "stop" to stop recording. 

Playback: Click "Play" to play back the most recent recorded data, and click "Pause" to pause 

playback. 

Click the "Continue" button to resume normal data acquisition and display. 

 

3.3.9 Professional or Basic settings 

Click "System" in the menu bar, then select "Setting Mode" to choose either "Basic" or 

"Professional" mode. Compared to the basic settings, the professional settings provide more 

parameters in the main settings area. Users can choose the appropriate setting mode based on 

application. 
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3.3.10 Hide panel 

Click the hide icon “ ” in the menu bar to hide the main settings menu and expand the display 

area. 

 

3.3.11 Current instrument information 

System-About, the current instrument information will be displayed in the "About" popup 

window. 
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3.3.12 Marker function 

The marker function is configured in the "Marker" submenu under the Graph Settings area. 

SAStudio4 also provides some quick operations to use markers. This section will explain in 

detail how to use markers in SAStudio4. 

1. Create Markers 

1) Create a Marker 

Double-click in the Graph Display area or click the "Peak Search" button in the Graph Settings 

area to quickly create a marker. 

2) Create multiple Markers 

Click the "Marker" submenu in the Graph Settings area, select the marker you want to create, 

and then click "Enabled" to activate the marker. 
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2. Create Marker pair 

Click "Graph" in the Graph Settings area, then select "Marker Pair" in the popup window to 

quickly create a pair of reference markers and delta markers. Click repeatedly to enable 

multiple pairs of markers(currently up to 5 groups). 

 

3. Close Markers 

1) Close a single Marker 

Click the "Marker" submenu in the Graph Settings area, select the marker you want to close, and 

then click "Enabled" to disable the selected marker. 
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2) Close All Markers 

Click "Graph" in the Graph Settings area, then select "Clear All" in the popup window to close all 

markers. 

 

4. Marker peak search 

1) Local peak search 

Double-click near the local peak in the graph, or select a marker and click "Marker" → "Local 

Peak" to enable local peak search. 
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2) Global peak search 

Click "Peak Search" to enable global peak search. 

 

5. Delta Marker 

The delta marker is typically applied alongside the reference marker to indicate the frequency, 

time and amplitude difference between the reference marker and the delta marker. 
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6. Noise density 

After creating a marker, open "NoiseDensity" in the "Marker" submenu under the Graph Settings 

area to convert the original power value into power density per Hertz. 

 

7. Marker to Center 

After moving the reference marker to the target frequency, click "to Center" in the "Marker" 

submenu under the Graph Settings area to align the marker's frequency to the center position. 
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8. Marker Switch To Mode 

After moving the reference marker to the target frequency, click the "Switch To" button in the 

"Marker" under the Graph Settings area to quickly switch to another working mode and set the 

frequency value of the current marker position as the center frequency of the new mode. 

 

3.3.13 Waterfall graph 

Waterfall plot functionality is supported only in SWP, IQS, and RTA modes. Click on the waterfall 

graph in the Graph Settings area to access the waterfall graph settings. The controls for the 

waterfall plot are introduced in the table 5: 
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Table 5 Waterfall Graph Controls 

Graph Settings Area  

Scan Depth the time length cached on the y-axis of the waterfall graph 

Time Density the refresh rate of the waterfall graph 

ColorGradation Sets the color gradient for the waterfall graph 

Click "Graph" to open "Spectrogram" and create a corresponding spectrum waterfall graph. 

 

3.3.14 Local zoom 

1. Spectrum Zoom (Only in SWP Mode) 

1) Click "Graph" and open "Zoom" in the pop-up submenu. 

2) Click to select the spectrum zoom graph, then click "Graph" and set the frequency range to 

zoom in on in the pop-up submenu. 
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2. Time Domain Zoom (Only in IQvT, PvT, and DET Modes) 

1) IQvT and PvT 

In IQS mode, click "IQvT" or "PvT" in the main settings area, select the corresponding channel, 

then open "Analyze" and "Zoom". Adjust the zoom area by holding and sliding the zoom box or 

dragging the zoom edges left or right. 

 

2) DET mode 

(1) Click "Graph" and open "Zoom" in the pop-up submenu. 

(2) Adjust the zoom area by holding and sliding the zoom box, dragging the zoom edges left or 

right, or selecting "PvT Zoom." Then click "Graph" to set "TimeCenter" and "TimeRange" to 

adjust the zoom area. 
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3.3.15 Record and Playback 

Please refer to table 6 for key parameters in record and playback function. 

Table 6 Record and playback parameter description 

Record  

RecordMode 

Fixed Duration: Allows presetting the number of recording points and 
file size (must not exceed file storage limit) 
Manual Mode: Requires manual control over the number of recording 
points 

RecordTime 
Set the recording duration, only effective when the record mode is 
"Fixed." 

FileSizeLimit The storage size limit for a single recording file. 

Disk the remaining and total disk capacity 

Playback  

Last frame Rewind by one frame 

Next frame Fast forward by one frame. 

Back Rewind by multiple frames. 

Forward Fast forward by multiple frames. 

1. Data recording 

Click "Record" in the main settings area, then click the "RecordMode" submenu to select the 

recording mode. 

Click "REC File Path" to set the storage path for the recording file. The default storage path is 

‘../userdata/SAStudio4/data’. 
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In Fixed Duration Mode, click "Record on" to automatically record the preset amount of data. In 

Manual Mode, click "Record on" and "Record off" to manually control the recording duration. 

The recording will automatically stop when the file size exceeds the available disk capacity. 

2. Data playback 

Click the "Open File" button under "Play Back" in the main settings area, select the recording file 

to be played back in the pop-up window, and click "Confirm." 

Click "Play Back" to start playback, "Pause" to stop, and "Stop" to exit playback and resume data 

acquisition. Set the "PlaybackRate" value to adjust the playback speed. Enabling "Auto Loop" 

will loop the playback of the selected file. 
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3.3.16 Export data 

1. Click "Graph" in the corresponding graph settings area, then select “DataExport” from the 

pop-up submenu. The “image” option allows you to export the chart data as an image, while the 

"Data" option exports the chart data as a CSV file. 

 

2. In the "Save" pop-up window, set the data save path and file name, then click "Confirm" to 

save the image/CSV file. If no external storage is connected, the file will be saved locally; if 

external storage is connected, you can choose to save directly to the storage device. 

 

3. The PX series instruments by default store data in the "images" (for chart images), "data" 

(for recorded files and configuration files), and "reports" (for chart data CSV files and 

corresponding configuration files) folders under the "userdata" - "SAStudio4_x.xx.xx" directory 

on the Desktop. 
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3.3.17 Delete files and images 

1. Click "File" → "Exit" to exit the SAStudio4 interface; 

2. Navigate to "userdata" - "SAStudio4_x.xx.xx" - "images," drag the image to the "Trash Can," 

and click "Yes" in the Confirm pop-up window to delete the screenshot (the method for 

deleting recorded files and configuration files is the same as for deleting screenshots). 

 

3.3.18 Modify sampling rate 

In IQS mode, click "BW" in the main settings area, and modify the value of "IQSampleRate" in the 

submenu to change the instrument's sampling rate. 
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3.3.19 Quick parameter settings 

The quick parameter settings currently support fast configuration of commonly used spectrum 

analysis parameters, including reference level, RBW (Resolution Bandwidth), VBW (Video 

Bandwidth), detector, start frequency, stop frequency, sweep span, center frequency, and 

more. 
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4. SWP Working Mode 

This chapter will provide you with important parameters and measurement methods for SWP 

mode. 

4.1 SWP Working Mode Parameters Overview 

Important parameters for the SWP mode are listed in Table 7. 

Table 7 Parameters description in SWP working mode 

Frequency  

LO optimization 

Auto: default low spurious mode; 
Speed: high sweep speed mode; 
Spur: low spurious mode; 
Phase noise: low phase noise. 

Amplitude  

Pre-Amplifier 

Preamplifier setting: 
Auto: automatically enables the preamplifier; When the reference 
level is below -30 dBm, the preamplifier is manually on or off; 
Forced off: always off. 

Gain Strategy 
Low Noise: minimizing noise while maintaining a flat noise floor. 
High Linearity: achieving high linearity while maintaining the noise 
floor flat. 

IF Gain Grade 

Gain grade 0-X: each grade for 3dB gain; 
Increase IF Gain Setting: RF gain decreases, noise floor increases, 
linearity improves, spurious signals decrease 
Decrease IF Gain Setting: RF gain increases, noise floor 
decreases, linearity degrades, spurious signals increase 

Attenuation 

0-33 dB (upper limit is different for different frequency bands), 
1 dB step; 
Atten = -1dB (default): attenuation is off. 

Atten ≥ 0dB: attenuation is enabled, and the reference level is 
calculated as Reference Level = Attenuation Value - 10. 

Sweep  

Sweep Time Mode 

min SWT: minimum sweep time; 
min SWTx2: approximately 2 times of min SWT; 
min SWTx4: approximately 4 times of min SWT; 
min SWTx10: approximately 10 times of min SWT; 
min SWTx20: approximately 20 times of min SWT; 

 

min SWTx50: approximately 50 times of min SWT; 
min SWTxN: approximately N times of min SWT, 
N=SweepTimeMultiple; 
Manual: approximately equal to the target sweep time. 

Trace Points Strategy 
Sweep Speed: priority is given to the fastest sweep speed; 
Points Accuracy: priority is given to ensuring that the number of 
trace points is close to the target. 

Spurious rejection Bypass, standard and enhanced. 
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4.2 Channel Power 

A BPSK signal with a carrier frequency of 1 GHz, power of -20 dBm and symbol rate of 1 MHz is 

as input to spectrum analyzer. 

4.2.1 Parameter description 

This section provides an explanation of some important parameters in channel power 

measurement mode, as listed in Table 8. 

Table 8 parameters for channel power measurement 

Channel Power  

Meas BW 
the bandwidth of the channel to be measured; channel power is 
the integrated power within this bandwidth 

Span Power 
the measurement bandwidth to the current span and calculates 
the channel power within this range 

4.2.2 Instruction steps 

1. Set the center frequency as 1 GHz and reference level as 0 dBm. Click the "Meas" menu and 

select "ChannelPower" from the dropdown menu; 

2. Parameters are automatically configured to default parameters. The results are shown in 

the figure below. The top left corner of the measurement box displays the channel power value. 

The "Channel Power" section below also shows the measurement bandwidth, channel power, 

and power spectral density values; 

FFT execution 

Auto: automatically selects the CPU or FPGA for FFT calculation 
based on the settings (using CPU for RBW below 30 kHz and 
FPGA for RBW above 30 kHz), CPU preferred, FPGA preferred, 
CPU Low Occ, CPU Mid Occ, CPU High Occ, FPGA only. 

Window 

FlatTop Window: higher amplitude accuracy. 
B-Nuttal Window: greater frequency selectivity. 
LowSideLobe Window: higher accuracy in measuring low-
frequency signals. 
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3. You can also manually adjust the channel center frequency (drag to select the 

measurement area) and the measurement bandwidth (drag the measurement border left or 

right or adjust the Meas BW settings). 

4.3 Occupied Bandwidth 

A BPSK signal with a carrier frequency of 1 GHz, power of -20 dBm and symbol rate of 1 MHz is 

as input to spectrum analyzer. 

4.3.1 Parameter description 

This section provides an explanation of some important parameters: Important parameters for 

occupied bandwidth measurement are listed in Table 9. 

Table 9 Occupied bandwidth measurement parameter description 

Parameters 

Method XdB、Percentage 

XdB/Percent the specific XdB value or percentage 

4.3.2 Instruction step 

1. Set the center frequency as 1 GHz and the reference level as 0 dBm. Click the "Meas" menu 

and select "OBW" from the dropdown menu; 

2. Parameters are automatically configured to default parameters. The results are shown in the 

figure below. The occupied bandwidth value can be viewed in the "OBW" section below. 
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4.4 Adjacent Channel Power Ratio (ACPR) 

A BPSK signal with a carrier frequency of 1 GHz, power of -20 dBm and symbol rate of 1 MHz is 

as input to spectrum analyzer. 

4.4.1 Parameter description 

This section provides an explanation of some important parameters: Important parameters for 

adjacent channel power ratio (ACPR) measurement are listed in Table 10. 

Table 10 ACPR measurement parameter description 

Parameters 

Space 
the frequency interval between the main channel and adjacent 
channels 

Count the number of adjacent channel pairs 

Main Power The power of the main channel 

Adj Center Center frequency of the adjacent channel 

Adj Power Measured power of the adjacent channel 

Adj Ratio Measured adjacent channel power ratio 

4.4.2 Instruction step 

1. Set the center frequency as 1 GHz and the reference level as 0 dBm. Click the "Meas" menu 

and select "ACPR" from the dropdown menu. 

2. Parameters are automatically configured to default parameters. The results are shown in the 

figure below. The power values of each channel are displayed at the top of the green channel 

bandwidth. The "ACPR" section below also shows the adjacent channel center frequency, 

adjacent channel power, and adjacent channel power ratio. 
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3. You can also manually set the center frequency of the main channel, the bandwidth of each 

channel, the spacing of adjacent channels, and the number of adjacent channel pairs. 

 

4.5 IP3/IM3 

Center frequency point of 1 GHz is utilized for IP3/IM3 measurement. 

4.5.1 Parameter description 

This section provides an explanation of some important parameters: Important parameters for 

IP3/IM3 measurement are listed in Table 11. 

Table 11 IP3/IM3 measurement parameter description 

IP3/IM3 

LowToneFreq Frequency of the input low-frequency signal 

LowTonePower Power of the input low-frequency signal 

HighToneFreq Frequency of the input high-frequency signal 

HighTonePower Power of the input high-frequency signal 

LowIM3PFreq Low-side intermodulation frequency 

LowIM3P Low-side intermodulation power 

HighIM3PFreq High-side intermodulation frequency 

HighIM3P High-side intermodulation power 

TonePowerDiff Power difference between the high and low 
frequency signals 
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4.5.2 Instruction step 

1. Two signals with one signal having a center frequency of 999 MHz and amplitude of 0 dBm, 

and the other having a center frequency of 1.001 GHz and amplitude of 0 dBm is combined using 

a combiner. Then it is as the input signal to the spectrum analyzer; 

2. Set the spectrum analyzer's center frequency as 1 GHz and the reference level as 0 dBm. 

Click the "Meas" menu and select "IM3" from the dropdown menu; 

3. Adjust the signal power so that the signal power displayed in the spectrum graph is 

approximately 6 dB below the reference level; 

4. Parameters are automatically configured to default parameters. The results are shown in the 

figure below. The "IM3" section at the bottom displays the IP3 test results. 

  

4.6 Frequency Tracking 

1. Click the "Marker" in the chart settings area. In the pop-up submenu, click "More", then click 

"Advanced". Set the peak threshold and jitter range for the tracking signal (When the signal 

being tracked jitters within the specified range, the position of the center frequency will not 

change due to the signal jitter). 
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2. Click "Signal Track". The reference marker will search for peaks within the current sweep 

span and align the peak signal to the center frequency position. When the target signal 

frequency drifts, the spectrum analyzer will automatically adjust its center frequency so that the 

signal always remains in the center of the display area, facilitating user observation and analysis. 

 

Note: Generally, this function only moves the frequency position and does not change the span. 

However, for signals with a particularly large drift that exceed the current span, tracking 

becomes difficult. For signals at the edge of the instrument's sweep range, the span will be 

further reduced due to frequency limitations. 
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4.7 Peak Table 

1. Click the "Marker" in the graph settings area. In the pop-up submenu, click "More", then click 

"Advanced". Set the threshold value for the peak table. For detailed settings, refer to the 

section Frequency tracking. 

2. Click "Peak Table". The spectrum analyzer will automatically detect and mark the peak points 

exceeding the threshold within the current sweep span (up to 10 peaks) and display frequency 

and power information of each peak in descending order of peak signal power in the peak table 

at the bottom of the display area, enabling users to quickly view the main signals in the 

spectrum. 
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5. IQS Working Mode 

This chapter provides a detailed introduction for important parameters of the IQS mode, 

including time-domain IQ data and spectrum analysis, power vs. time analysis, digital down-

conversion, demodulation, etc. 

5.1 IQS Parameters Overview 

Table 12 IQS parameters overview 

Frequency 

LO optimize Please refer to SWP working mode for reference 

BW 

Sample rate ADC sample rate: 110MSa/s ~ 130MSa/s 

Analysis 
bandwidth 

Equivalent sampling rate after decimation: ADC sampling rate / 
decimation factor 

Data format 

8-bit: low precision, there may be many zeros in the absence of a 
signal, supporting streaming acquisition with decimate factor 
higher than 2. 
16-bit: default configuration, supporting streaming acquisition 
with decimate factor higher than 4. 
32-bit: high precision, supporting continuous streaming 
acquisition with decimate factor higher than 8. 

Amplitude 

Preamplifier 

Please refer to SWP working mode for reference 
Gain strategy 

IF gain grade 

Attenuation 

Record 

RecordMode 

Please refer to Record and Playback in SWP working mode for 
reference 

RecordTime 

FileSizeLimit 

Disk 

Playback 

Last frame 

Please refer to Record and Playback in SWP working mode for 
reference 

Next frame 

Back 

Forward 
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5.2 IQS Working Mode Overview 

The UI of the IQS mode is shown in the figure below, consisting of a maximum power vs time 

thumbnail, spectrum graph, and time-domain graph. Click "Next" in the main settings area, then 

click "Trigger". Modify the "PreviewTime" value in the submenu to change the preview time of 

the IQ stream in the maximum power vs time thumbnail. 

The spectrum graph and IQ time-domain graph are determined by the red selected boxes 

"Spectrum-P" and "IQvT-P" in the maximum power vs time thumbnail, respectively. By changing 

the selection range, you can observe the IQ time-domain signals at different time intervals, and 

you can also perform spectrum analysis on the IQ time-domain signals at different times. 

 

5.3 Spectrum Analysis 

5.3.1 Parameter description 

This section provides an explanation of some important parameters for spectrum analysis listed 

in table 13. 

Table 13 Parameter description for spectrum analysis 

Spectrum analysis 

Window Please refer to SWP working mode for reference 

Spectrum 
Intercept 

Spectrum interception: If Intercept = 0.8, 80% of the FFT spectrum 
analysis results are displayed in order to intercept the transition band 
spectrum components. 

5.3.2 Operation instructions 

1. Click "FFT" in the main settings area to enable "Analyze", Drag the red box "Spectrum-P" in 

the maximum power vs time thumbnail, or adjust the values of "TimeStart" and "TimeLength" to 

perform spectrum analysis at different time intervals. Adjust the values in the "Center" submenu 

of "Frequency" and the "Span" submenu of "BW" to change the center frequency and analysis 
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bandwidth; 

2. Use "FFTsize" to set the number of points for spectrum analysis, "Window" to set different 

window functions, "TraceDetector" to set different trace detectors, and "Intercept" to intercept 

and display the spectrum. When Intercept = 0.8, it can intercept the transition band. 

 

5.4 IQvT 

5.4.1 Operation instructions 

Click "IQvT" in the main settings area to enable "Analyze", drag the red selection box "IQvT-P" in 

the maximum power vs time thumbnail, or adjust the values of "TimeStart" and "TimeLength". 

This allows you to perform time-domain analysis at different time intervals. 
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5.5 PvT 

5.5.1 Operation instructions 

Click "PvT" in the main settings area to enable "Analyze". Drag the red selected box "PvT-P" in 

the maximum power vs time thumbnail, or adjust the values of "TimeStart" and "TimeLength". 

This allows you to perform power versus time analysis on IQ signals at different time intervals; 

 

5.6 AM Demodulation 

The AM signal with a carrier frequency of 1 GHz, power of -20 dBm, modulation rate of 3 kHz 

and modulation depth of 70% is employed as an example. 

5.6.1 Parameter description 

This section provides an explanation of some important parameters for AM demodulation, listed 

in table 14. 

Table 14 AM demodulation parameter description 

Filter submenu 

n Number of filter taps. The larger the number taps, the steeper the 
transition band of the filter and the smaller the passband ripple 

Fc Cutoff frequency, 0 < Fc < 0.5. For example, if Fc is 0.25, then low-pass 
filtering is performed on half of the bandwidth. 

As Stopband attenuation. The larger the stopband attenuation, the 
stronger the suppression effect on the stopband in dB. 

mu Fractional sample offset, recommended to use the default value. 

5.6.2 Operation instruction 

1. Set the "Center Frequency" as 1.0001 GHz, adjust the range of the "IQvT-P" in the maximum 

power vs time thumbnail, select the IQ time domain graph, click "Graph", and choose "Auto 
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Range" in the Graph submenu. 

2. Click "Demod" in the main settings area, set "Type" to AM in the submenu, select the AM 

demodulated time-domain graph, and click "Auto Range" under the "Graph" control. 

3. Click "BW" in the main settings area, increase the "Span" in the submenu to adjust the 

analysis bandwidth. In this example, set the analysis bandwidth to 15.36 MHz. 

 

5.6.3 Audio analysis 

This function is used to test the demodulation sensitivity of the instrument. 

1. Refer to the AM demodulation section to demodulate the AM signal. 

2. Click "Demod" in the main settings area, open "AudioAnalysis" in the submenu, enable audio 

analysis, and check if the frequency of the audio analysis matches the modulation rate. You can 

also test the signal-to-noise ratio and total harmonic distortion. 
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5.7 FM Demodulation 

The FM signal with a carrier frequency of 1 GHz, power of -20 dBm, modulation frequency of 5 

kHz, and frequency deviation of 75 kHz is employed as an example. 

5.7.1Parameter description 

Please refer to AM demodulation for reference. When listening to FM broadcasting, low-pass 

filtering can be applied to the demodulated FM signal to reduce some high-frequency noise, 

making the voice cleaner. 

5.7.2 Operation instruction 

1. Set the "Center Frequency" as 1 GHz, adjust the range of the "IQvT-P" in the maximum 

power vs time thumbnail, select the IQ time domain graph, click "Graph", and choose "Auto 

Range" in the Graph submenu. 

2. Click "Demod" in the main settings area, set "Type" to FM in the submenu, select the FM 

demodulated time-domain graph, and click "Auto Range" under the "Graph" control. 

3. Click "BW" in the main settings area, increase the "Span" in the submenu to adjust the 

analysis bandwidth. In this example, set the analysis bandwidth to 7.68 MHz. 
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5.7.3 Audio analysis 

After demodulating the FM signal, please refer to audio analysis section to analyze the 

demodulated signal. The analysis results are shown below: 

 

5.8 DDC-Digital Down Conversion 

Perform digital down-conversion and resampling on the IQ data stream to generate sub-IQ 

streams for further spectrum analysis. Taking the DDC of a single-tone signal with a frequency 

of 1 GHz and power of -20 dBm as an example. 

5.8.1 Parameter description 

This section provides an explanation of some important parameters for digital down-

conversion (DDC), listed in Table 15. 
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Table 15 DDC parameter description 

Sampling submenu 

OffsetFreq 
Frequency offset of complex mixing 
>0: Spectrum shifts to the right 
<0: Spectrum shifts to the left 

Decimate decimation factor for the DDC, i.e., the resampling rate 

5.8.2 Operation instruction 

1. Set "Center" as 1 GHz and "Ref.Level" to 0 dBm. Adjust the range of "IQvT-P" in the maximum 

power time thumbnail, select the IQ time-domain graph, click "Graph", and choose "Auto Range" 

from the Graph submenu. 

2. Click "DDC" in the main settings area, enable "Channel1", and set the "Center" of the DDC1 

channel to 1.003 GHz, "OffsetFreq" to -3 MHz, "Step" to 1 MHz, and "Decimate" to 3. 

 

3. Click "FFT" in the main settings area, select "DDC1 Channel" from the dropdown menu, 

enable "Analyze", drag the red selection box "Spectrum-D1" in the maximum power time 

thumbnail, or adjust the "TimeStart" and "TimeLength" values to perform spectrum analysis on 

the sub-IQ streams generated by the DDC at different time intervals. 
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4. Click "IQvT" in the main settings area, select "DDC1 Channel" from the dropdown menu, 

enable "Analyze", drag the red selection box "IQvT-D1" in the maximum power time thumbnail, 

or adjust the "TimeStart" and "TimeLength" values to perform time-domain analysis on the sub-

IQ streams generated by the DDC at different time intervals. 

 

5. Click "PvT" in the main settings area, select "DDC1 Channel" from the dropdown menu, 

enable "Analyze", drag the red selection box "PvT-D1" in the maximum power time thumbnail, or 

adjust the "TimeStart" and "TimeLength" values to perform power vs. time analysis on the sub-

IQ streams generated by the DDC at different time intervals. 
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6. DET Working Mode 

This chapter provides a detailed introduction to some parameters of the DET mode and the 

measurement of pulse signals in this mode. 

6.1 DET Parameter Description 

This section provides an explanation of some important parameters for the DET mode, listed in 

Table 16. 

Table 16 DET working mode description 

Frequency 

LO optimize Please refer to SWP working mode for reference 

Amplitude 

Preamplifier 

Please refer to SWP working mode for reference 
Gain strategy 

IF gain grade 

Attenuation 

6.2 Pulse Signal Measurement 

A pulse modulation signal with a carrier frequency as 1 GHz, power of -10 dBm, pulse period of 

80 µs, and pulse width of 40 µs as an example. 

6.2.1 Operation instruction 

1. Set the "Center" as 1 GHz and click the "Single" in the menu bar to enable the single preview 

mode; 

2. Click "Graph" in the chart settings area, then click "Zoom" to enable zooming. Adjust the 

zoom area by dragging the selected zoom area or dragging the zoom border left or right. 

3. Select the zoomed-in graph, click "Graph" in the chart settings area, and choose "Marker 

Pair" to create two pairs of markers. Move the M1R marker to the pulse rising edge, M1D marker 

to the same pulse falling edge, M2R marker to the pulse rising edge, and M2D marker to the next 

pulse rising edge. The results displayed by the M1D and M2D markers in the top left corner of 

the zoomed-in graph will be the pulse width and pulse period of the pulse signal, respectively. 

The duty radio can be calculated using the following formula. 

Duty radio =
Pulse width

Pulse period
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6.3 Pulse Signal Detection (Option72) 

This chapter introduces the basic operation methods for pulse signal detection and how 

customers who purchase the pulse detection option later can obtain and place the license. 

6.3.1 Apply for License 

If the pulse detection option was included when you purchased the device, you can ignore the 

content of this section. If you purchase the pulse detection option later, please follow the steps 

below to obtain and place the pulse detection license to use this feature properly. 

1. Click on "System" in the menu bar, select "About" from the dropdown menu, and check the 

version information in the popup window; 
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2. Ensure the version meets the following requirements; 

▪ GUI Version: 4.3.55. 6 or above 

▪ API Version: 0.55. 55 or above 

▪ FPGA Version: 0.55. 15 or above 

▪ MCU Version: 0.55. 32 or above 

3. If the software and firmware versions do not meet the above requirements, please refer to 

the Software and Firmware Update section to update them to the required versions;  

4. After updating the software and firmware to the required versions, send a screenshot of 

the entire interface to the official technical support of HAROGIC Technology to apply for the 

pulse detection license for the respective device. The required interface schematic is as follows: 

 

5. Click "File" → "Exit" to exit the SAStudio4 running interface; 

6. Copy the license obtained from technical support to a USB drive, then connect the USB 

drive to the USB port on the instrument's front panel, and click "OK" in the pop-up window 

"Removable medium is inserted"; 

7. Copy the pulse detection license from the USB drive to the desktop by dragging and 

dropping; 
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8. Navigate to "userdata" → "SAStudio4_x.xx.xx" → "bin" → "CalFile", and drag and drop the 

pulse detection license file into the "CalFile" folder; 

 

9. Close the pop-up window and launch the SAStudio4 software, click "Mode" in the menu bar, 

select "Power Detection" to enter the detection analysis mode, enable "Pulse Det" in the main 

settings area, and the pulse signal detection function can be used normally; 
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6.3.2 Parameter Description 

Only some important parameters are explained here: Important parameters for pulse signal 

detection are shown in Table 17.Error! Reference source not found. 

Table 17 Pulse Signal Detection Parameter Description1 

Pulse Det 

Threshold 
Pulse detection threshold, only pulse signals greater than this 
threshold value will be considered valid pulses. 

Maximum Number 
of Pulses Upper limit of pulse signal detection at current preview time 

6.3.3 Operating Steps 

Taking the detection of a pulse signal with 1 GHz, -20 dBm, pulse width of 40 us, and pulse 

period of 80 us as an example. 

1. Set "Center" to 1 GHz and "Ref.Level" to 0 dBm; 

2. Click "BW" in the main settings area and adjust the value of "BW" in the additional menu to 

set different analysis bandwidths. In this example, set "AnalysisBW" to 62.5 MHz; 
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3. Click "Trigger" in the main settings area and set "PreviewTime" to 500 us; 

 

4. Click "Pulse Det" in the main settings area to enable the pulse detection function. Drag the 

value of "Trigger.Level" in the power time graph to set the pulse detection threshold, and adjust 

the value of "MaxPulseCount" to set the upper limit of pulse signal detection under the current 

preview time; 
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5. Click "Single" in the menu bar, and the pulse detection results under the current 

configuration are shown in the figure below. From the figure, you can obtain parameters such 

as the peak level (dBm), reference level (dBm), rise time, leading edge, fall time, trailing edge, 

pulse width, period, and duty cycle of each detected pulse signal. Also, the statistical 

parameters of the detected pulse signals, such as the maximum, minimum, average pulse period 

and width, period deviation percentage, and pulse width deviation percentage. 

 

6. If the user encounters a measurement freeze/stop state during pulse detection, this can 

be avoided by reducing the analysis bandwidth or increasing the pulse period. 
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7. RTA Working Mode 

This chapter provides a detailed introduction to some parameters of the RTA mode and the 

measurement of WIFI signals in this mode. 

7.1 RTA Parameter Description 

This section provides an explanation of some important parameters: Important parameters for 

RTA mode are listed in Table 18. 

Table 18 RTA mode parameter description 

Frequency 

LO optimize Please refer to SWP working mode for reference 

Amplitude 

Preamplifier 

Please refer to SWP working mode for reference 
Gain strategy 

IF gain settings 

Attenuation 

Sweep 

Sweep Time Mode 
Please refer to SWP working mode for reference 

Window 

7.2 Probability Density Graph 

7.2.1 Parameter Description 

Graph 

Probability Graph On: Enable probability density graph display 
Off: Disable probability density graph display 

Color Scale Sky color, Deep sea color (default), Jet color, Cool color, 
Hot color, Grayscale 

Afterglow Increase: Extend the signal afterglow display time, 
suitable for capturing burst signals 
Reduce: Speed up refresh rate, suitable for tracking 
continuous signals 

7.2.2 Close probability density graph 

Click "Graph" in the chart settings area, and in the pop-up window, close "BitMap" to close the 

probability density graph. 
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7.3 WIFI Signal Measurement 

1. Connect the antenna to the RF input port "RFIN"; 

2. Set the "Center" as 2.44 GHz. Increase the "Afterglow" value in the "Graph" submenu of the 

chart settings area to observe the WIFI signal more clearly. 
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8. Digital demodulation (option) 

This chapter introduces the basic operation methods of digital demodulation and how 

customers can enable the digital demodulation function through a license. 

8.1 Apply for License 

If your device purchase includes the digital demodulation option, you can ignore the content of 

this chapter. If you purchase the digital demodulation option later, please follow the steps 

below to obtain and place the digital demodulation license for normal use of this function. 

1. Refer to the pulse signal detection license application chapter to apply for the 

corresponding device digital demodulation license and place it in the "CalFile" folder;  

2. Close the pop-up window and launch SAStudio4 software, click on the "Mode" menu, 

select "Digital Demod", and you can use the digital demodulation function normally. 

 

8.2 Parameter Description 

Here, only some important parameters are explained: Some important parameters are shown in 

Table 19.Error! Reference source not found. 

Table 19 Parameter description for digital demodulation 

Digital Demod 

SymbolRate 
The number of symbols transmitted per second by the signal needs 
to be filled in according to the symbol rate of the modulated signal 
to ensure that the receiving end can demodulate correctly 

Demod type 
AM、FM、PM、CW、LSB、USB、2ASK、2FSK、4FSK、BPSK、

QPSK、16QAM、64QAM 

FilterAlpha 

The roll-off rate of the filter used to limit the signal bandwidth in the 
transition band must be consistent with the roll-off coefficient at 
the transmitter to ensure that the demodulator can effectively 
process and demodulate the signal correctly. 
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8.3 Function Overview 

The initial UI of the digital demodulation mode is shown in the figure below, consisting of the 

modulation signal spectrum, demodulated constellation diagram, eye diagram, and 

demodulation parameters. It allows for an in-depth analysis of the modulation quality of the 

signal and provides various error metrics to effectively evaluate the integrity and reliability of 

the signal during transmission. 

 

8.4 Operating Steps 

Take the demodulation of a 1 GHz, -20 dBm, symbol rate 100 kHz, filter roll-off factor 0.35, 

64QAM signal as an example. 

1. Set "Center" to 1 GHz, "RefLevel" to 0 dBm; 

2. Click "Demod" in the main settings area, set "ModType" in the additional menu to QAM64, 

"SymbolRate" to 100 KSPS, "FilterType" to 0.35, and click "Single" in the menu bar. The 

demodulation result under the current configuration is shown in the figure below. The 

constellation points in the constellation diagram are clear and closely distributed, with the 

theoretical and actual demodulation point positions almost coinciding, indicating high 

modulation quality of the signal and good overall performance of the communication system. 

The eye diagram is clear with a large opening, indicating minimal inter-symbol interference, 

allowing the receiver to reliably distinguish symbols. Meanwhile, it also provides error vector 

magnitude (EVM), amplitude error, phase error, frequency error, signal-to-noise ratio 

(SNR/MER), and part of the decoded bit sequence. 
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9. Phase Noise Measurement Mode 

9.1 Version Requirements 

1. Click “System” in the menu bar, select “About” in the drop-down menu, and view the version 

information in the pop-up window. 

 

2. Ensure the version meets the following requirements 

▪ GUI Version: 4.3.55.12 or above 

▪ API Version: 0.55.58 or above 

▪ FPGA Version: 0.55.17 or above 

▪ MCU Version: 0.55.49 or above 

3. If the software/firmware version does not meet the above requirements, please refer to the 

software/firmware update section to update the software/firmware to the required version. 

Soft Firmware Update 

9.2 Enable Phase Noise Measurement Function 

After updating the software/firmware to the required version, restart the SAStudio4 software, 

click "Mode" in the menu bar, and select "Phase Noise" to use the phase noise measurement 

function normally. 
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9.3 Parameter Description 

Here, only some important parameters are explained: Some important parameters of phase 

noise measurement are shown in Table 20. 

Table 20 Phase Noise Measurement Mode Parameter Description2 

Frequency  

Start Frequency Offset Set the starting point of the frequency offset, range: 1~10 MHz 

Stop Frequency Offset Sets the end point for the frequency offset, range: 10~10 MHz 

Carrier Identification 
Threshold 

Set the carrier identification threshold; only carriers above this 
threshold will be identified. 

Search Carrier 
Search the entire frequency band to locate signals above the 
carrier identification threshold. 

Meas  

RBW/Offset 
RBW ratio (RBW of each frequency segment / starting frequency 
of each frequency segment), range: 0.01~0.3 

Detection Settings 

Frame Detection Rate: Recommended to use the default 
configuration. If there is obvious low-frequency jitter near the 
signal under test, the frame detection rate near the end can be 
increased to obtain more stable measurement results. 

Trace  

Average Sets the number of trace averages 

Smooth On: Enables trace smoothing function 
Off: Disables trace smoothing function 

Window Length Sets the window length of the smoothing algorithm, range: 0~10% 
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9.4 Operation Steps 

9.4.1 Phase Noise Measurement with Known Carrier Information 

Taking the measurement of phase noise of a 1 GHz, 0 dBm signal in the 100 Hz to 10 MHz 

offset range as an example. 

1. Click ‘Frequency’ in the main settings area, and in the additional menu, set ‘Center 

Frequency’ to 1 GHz, “Start Frequency Offset” to 100 Hz, and “Stop Frequency Offset” to 10 

MHz. It is recommended to use the default configuration for the remaining parameters; 

 

2. If there is strong jitter at the near end of the signal under test, click "Meas" in the main 

settings area, then select "Detection Settings" in the additional menu. In the pop-up window, 

appropriately increase the frame detection rate of the corresponding frequency band to obtain 

more convergent measurement results; 

 

3. If there are obvious spurs in the single sideband phase noise spectrum, you can click "Trace" 
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in the main settings area, then select "Window Length" in the additional menu, and gradually 

increase its parameter value to reduce the interference of spurs on the measurement results; 

 

4. The instrument will automatically complete the phase noise measurement within the set 

frequency offset range, and the measurement results are shown below. In the phase noise 

measurement table at the bottom of the interface, you can obtain the carrier information and 

the phase noise values of each characteristic frequency offset point (unit: dBc/Hz). 

 

9.4.2 Phase Noise Measurement of Unknown Carrier Information 

When the signal carrier parameters are unknown, it is recommended to perform phase noise 

measurement according to the following process. (Assuming that the unknown carrier signal is 

2 GHz, -10 dBm at this time) 

1. Click "Carrier Search", the instrument will automatically perform a full-band scan, search for 

and locate the peak signal exceeding the carrier threshold as the carrier under test; 
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2. After locating the carrier signal, refer to the Phase Noise Measurement of Known Carrier 

Information section to set the start frequency offset and end frequency offset for phase noise 

measurement. 
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10. Additional Functions 

In this chapter, you can find detailed information for how to operate GNSS, trigger and remote 

control etc. 

10.1 GNSS Operation Guide 

10.1.1 Connect GNSS antenna 

Connect GNSS antenna and MMCX-SMA convertor and then use the MMCX side to connect 

with GA port (port 14), shown in the below figure (When using external GNSS antenna, please 

make the receiving side of antenna towards sky without obstructions). 

 

10.1.2 GNSS information check  

1. Open SAStudio4 and click System in the menu to choose GNSS Info. In the dialog box, 

choose antenna as “GNSS_AntennaExternal”; 

2. Wait for 1-3 minutes for the GNSS to lock. You can determine whether the GNSS is locked 

based on the GNSS lock icon in the status bar. The GNSS lock icon is green when locked, 

otherwise gray. 
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10.1.3 1PPS trigger in GNSS module 

The 1PPS trigger of the external GNSS module can be used only in IQS, DET, and RTA mode. 

1. Please refer to Connect GNSS antenna section for connecting antenna with instrument; 

2. Please refer to GNSS Information Check section for ensuring GNSS is locked; 

3. Click “Mode” to choose “IQStreaming” to enter into IQS mode; 

4. Main setting area- Tigger, set trigger source as “GNSS-1PPS” to enable 1PPS trigger in the 

GNSS module. 

 

10.1.4 GNSS application note 

When the GNSS module is not locked, it is not recommended to use the GNSS 1PPS and 10MHz 

clock signal outputs. 



 

65 

10.2 Trigger Features Overview 

10.2.1 SWP working mode 

Trigger In 

Trigger Source FreeRun, External PerHop, External PerSweep, External PerProfile 

Trigger Edge RisingEdge, FallingEdge, Double Edge 

Trigger Out 

Trigger Out 

Null; 

PerHop: Output a trigger after each frame analysis is completed  

PerSweep: Each time a trace scan is completed, a trigger is output  

PerProfile 

Trigger Out Pulse 
Polarity Positive、Negative 

10.2.2 IQS、DET、RTA working mode 

Trigger In 

Trigger Source 
External, Bus, Level, Timer, DevSyncByExt, DevSyncBy1PPS, 

GNSS1PPS 

Trigger Mode Fixed, Adaptive 

Trigger Edge RisingEdge, FallingEdge, DoubleEdge 

Trigger Delay Set the delay time after triggering 

PreTrigger Set the acquisition time before triggering 

ReTrigger 
At FixedPoints mode, the instrument responds multiple times 

after capturing a trigger 

Count 
After a single trigger response, several additional responses are 

required 

Period 
The time interval between multiple responses of a single-trigger 

instrument is same as trigger period in the timer trigger mode  

Period (RTA) The actual sampling time of the instrument after triggering  

Trigger In- Level 

Trigger Level Set the level trigger threshold value. If the value is higher than 

the threshold value, it means the trigger condition is met.  
Debounce SafeTime Set the level-triggered debounce safety time 

TriggerIn-Timer 

Period Trigger period in timer trigger mode 
Sync Not synchronized with the external trigger 

Synchronized with the external trigger’s rising edge  

Synchronized with the external trigger’s falling edge  
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Single-shot synchronization with the external trigger’s rising 

edge 

Single-shot synchronization with the external trigger’s falling 

edge 

Synchronization with the GNSS-1PPS rising edge 

Synchronization with the GNSS-1PPS falling edge 

Single-shot synchronization with the GNSS-1PPS rising edge 

Single-shot synchronization with the GNSS-1PPS falling edge 

10.3 IF Output 

The frequency of the analog IF output signal is between 307.2MHz±50MHz. The center 

frequency of the analog IF output of each instrument can be viewed in the IF calibration file of 

the instrument. 

 

10.4 External Reference Clock Input 

The waveform of the reference clock input can be selected as sine wave, square wave or 

clipped sine wave. The frequency must be set to 10 MHz and the amplitude must be 3.3V CMOS 

level. 

Below is the GPSDO as the 10 MHz reference clock input: 

1. Connect the GPSDO "10 MHz" port to the instrument's "RI" port via a BNC to MMCX cable. 

The connection is shown below: 
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2. Click "Next"-"System" in the main setting area, set the reference clock frequency 

"RefCLKFreq" to 10 MHz, and select "External" for the reference clock source "RefCLKSource". 

If the reference clock source displays "External", it means the switch is successful. If the 

reference clock source rebounds to "Internal" and an error pop-up window appears, it means 

the switch failed. At this time, you can click "Preset" to switch back to the internal clock. 

 

10.5 Remote Control 

10.5.1 Using LAN port 

1. Connect the driver-free expansion dock with network port to the USB port on the upper 

panel of the instrument (USB3 is USB3.0 port, USB1 and USB2 are USB2.0 ports); 
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2. Connect the expansion dock to the network port of the computer or embedded instrument 

via a network cable; 

 

3. Click "File" - "Exit" in the menu bar to exit SAStudio4; 

4. After successfully connecting according to the above steps, open "Settings", select "Network 

& Internet", and click "Properties"; 

5. Enter Ethernet, find the IP section and click "Edit"; 

 

6. Select "Manual" to set IP, turn on the IPv4 option, and set the IP address and subnet mask (the 

computer IP and the instrument IP must be in the same network segment). For example, set the 

computer IP address to 192.168.1.2 and the subnet mask to 255.255.255.0; 
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7. Open the cmd window and enter "ping 192.168.1.100". If it can be pinged, the network 

connection is successful; 

 

8. Go to the \SAStudio4\configuration\ folder on the PC, double-click to open the Settings.ini 

file, and set Interface to ETH; 

 

9. Click "Userdata" → "SAStudio4_X.XX.XX" → "bin" → "CalFile" on the instrument desktop, 

and save the calibration file to the external storage device by dragging and dropping. 
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10. Copy the instrument calibration to "..\SAStudio4\bin\CalFile" on the PC, double-click 

SAStudio4.exe under "SAStudio4\bin" on the PC to open the SAStudio4 interface to achieve 

remote control of the PX series instruments. 

 

 

Note: The SAStudio4 on the PC and instrument cannot be opened at the same time. 

10.5.2 Using local area network 

1. Connect the driver-free expansion dock with network port to the USB port on the upper panel 

of the spectrum analyzer (USB3 is USB3.0 port, USB1 and USB2 are USB2.0 ports); 

2. Connect the Hub to the router's network port via an Ethernet cable; 
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3. Click "File" → "Exit" in the menu bar to exit SAStudio4; 

4. Click "userdata" → "Tools" → "Open Current Folder in Terminal"; 

 

5. Enter "ifconfig" in the terminal to query the IP address assigned to the instrument by the 

current router. In this example, the IP address is "192.168.31.55"; 
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6. Connect the PC to the same router via WIFI, and be in the same LAN as the spectrum analyzer. 

Enter the “\SAStudio4\configuration\” folder, double-click to open the “Settings.ini” file, set 

the Interface to ETH, and set the Address to "192.168.31.55" 

 

 

7. Click "Userdata" → "SAStudio4_X.XX.XX" → "bin" → "CalFile" on the desktop, and save the 

calibration file to the external storage device by dragging and dropping; 
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8. Copy the instrument calibration to "..\SAStudio4\bin\CalFile" on the PC, double-click 

“SAStudio4.exe” under "SAStudio4\bin" on the PC to open the SAStudio4 UI to achieve remote 

control of the PX series instruments. 
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11. Software and Firmware Update 

This chapter describes how to use the updater to update the MCU firmware, FPGA firmware, 

GNSS firmware, and SAStudio4 software of the PX series instrument 

11.1 Version Requirements 

The instrument firmware update must meet the following version requirements: The firmware 

version must be 0.54.0 or higher. If the GNSS module is updated, the MCU firmware version 

must be 0.55.32 or higher. The version can be viewed as follows: Click "System"-"About" in the 

menu bar to view the current instrument version information. 

 

After firmware updates, you need to ensure that the instrument's MCU firmware, FPGA firmware, 

and SAStudio4 software (API) are in the same major version. Different major versions are 

incompatible with each other. For example, they must be 0.55.x to work properly. 

11.2 Update Package Download 

Visit the HAROGIC official website(https://www.harogic.com/support/download-center/) to 

download and unzip the firmware update package to the desktop. 

https://www.harogic.com/support/download-center/
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11.3 Firmware Update Using Updater 

Note: If an error occurs in the update process, please refer to Error Check section. 

1. Please refer to Remote Control section, connect the instrument with PC and ensure they are 

in the same network segment. 

2. Open Updater 0.55 M39F15 file and double click to run Updater_Win.exe. 

 

3. When the instrument is under update, SAStudio4 software will be updated first. As shown in 

the figure, wait for about 2 minutes to complete the update. During this period, if the instrument 

displays -1 or other errors, do not process them, just wait for the update to complete. 
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4. After the SAStudio4 software is updated, the program will display the current instrument 

firmware version and the new firmware version in the update program. After confirming that 

they are correct, press Enter to start the update. (In the following, Updater 0.55 M39F15 is used 

as an example. M39 is MCU 0.55.39, and F15 is FPGA 0.55.15). 

 

5. The terminal will display the update progress during the update. The MCU update time is 

about 4 minutes, and the FPGA update time is about 15 minutes. 

 
6. The GNSS firmware will be automatically updated while the program is running. 

 

7. After the update is completed, press Enter to end the update or simply click the cross in the 
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upper right corner to close the program. 

 

8. Restart the instrument to check the current version. 

 

11.4 Software Update Using .deb Package 

If you only want to update SAStudio4 without updating the firmware or cannot use the network 

port to remotely control the instrument, you can directly use the .deb installation package to 

update. The process is as follows: 

1. download the PX series software installation 

package(https://www.harogic.com/support/download-center/) and copy it to a USB flash 

drive. 

https://www.harogic.com/support/download-center/
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2. Open the instrument normally, click “File” → “Exit” in the menu bar to exit SAStudio4. 

3. Use a hub with a USB or Type-C interface to connect the USB flash drive carrying the .deb 

installation package and the mouse and keyboard to the instrument. 
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4. Copy the .deb installation package in the USB flash drive to the instrument. 

5. Click Tools, then click Open Current Folder in Terminal to open the terminal. 

 

6. Enter cd ~/Desktop/ to enter the desktop. 

7. Type sudo dpkg -i EN_PXConfig_2.55.29.11.deb to Install the .deb installation package and 

enter the password rpdzkj as prompted. 

 

8. Then wait for the installation package to complete. 
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9. After the software is updated, check the SAStudio4 software GUI and API to confirm whether 

they have been updated to the latest version. 

 

11.5 Error Check 

11.5.1 Firmware update error 

If during the firmware update process, the Updater program displays an error message 

indicating that it cannot detect the firmware as shown in the figure, no action is required and 

just continue to wait until the program detects the firmware. 
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11.5.2 Firmware corruption error 

If the instrument fails to update the firmware due to unexpected circumstances such as network 

disconnection or power outage during the process of updating the MCU, FPGA, or GNSS, 

please restart the Updater program and wait for SAStudio4 to update. After that, the situation 

shown in the figure will appear. Follow the prompts to enter the instrument model into the 

terminal and press Enter to re-update (here we take the PXE-200 R3 instrument as an example). 

 

Wait for the update to complete and then close the program. 

 
11.5.3 SAStudio4 accidental deletion 

If you accidentally delete SAStudio4 during normal use of the instrument and the instrument 

becomes unusable, you can repair SAStudio4 according to the .deb update SAStudio4 process. 
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11.5.4 SAStudio4 update failed 

If SAStudio4 update is interrupted by unexpected events such as network disconnection or 

power outage during the SAStudio4 update process, shown in the figure. At this time, you must 

first repair SAStudio4 according to .deb package update SAStudio4, and then you can update 

the firmware normally according to Firmware Update. 
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